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1.0 INTRODUCTION 

1.1 Purpose 

The purpose of this document is to provide training material for instruction in the use of 

IC-Inspection for online inspection and NEXUS Integrity Centre (NEXUS IC) for offline 

review. 

1.2 Scope 

This document covers functionality relating to online inspection and offline review using 

IC-Inspection and NEXUS IC products only. Training documentation for NEXUS IC is 

covered by the NEXUS Integrity Centre Training Manual and training for IC-Inspection is 

covered by the IC-Inspection Training Manual. 

1.3 Course agenda 

1. Introduction to IC-Inspection. 

2. Perform a pipeline Inspection using IC-Inspection. 

3. Perform a structural Inspection using IC-Inspection. 

4. Post inspection review of recorded event data. 

 

1.4 Pre-training checklist 

Training PC’s have following applications installed:   

 NEXUS IC   

 IC-Inspection   

 IC-Video   

 Digital Video Player (DVP)   

 VisualReview   

 MS Office   

 SQL Express (for local database connection)   

Training PC’s have the following training material copied to local drive:   

 Inspection video   

 Smoothed pipeline survey file (for track repositioning)   

Training PC’s have dual monitor   

Training database is restored to training PC’s   
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2.0 TERMS AND ABBREVIATIONS 

AIG Asset Information Group 

Child Assets In a hierarchical list, an Asset’s children (Child Assets) are any assets 

which exist below it in the hierarchy. 

CP Cathodic Protection 

CSV Comma Separated Values 

DV Digital Video 

DVP Digital Video Player 

DVR Digital Video Recorder 

GEP Gas Export Pipeline 

GVI General Visual Inspection 

IC Integrity Centre 

IC-Inspection Integrity Centre - Inspection (Wood Proprietary Software) 

IP Internet Protocol 

KP Kilometre Point 

NEXUS IC NEXUS Integrity Centre (Wood Proprietary Software) 

m Metres 

MS Office Microsoft Office 

PC Personal Computer 

ROV Remote Operated Vehicle 

Shift Check IC-Inspection desktop to check at the start of each shift 

SQL Structured Query Language 

SQL Server Relational Database Engine (Microsoft SQL Server software) 

VDM Vertical Diagonal Member 
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3.0 ONLINE INSPECTION USING IC-INSPECTION 

Online inspection is carried out using IC-Inspection. 

3.1 Start IC-Inspection and connect to database 

IC-Inspection is started by navigating to Start > All Programs > NEXUS and clicking on 

IC-Inspection.  Once the software has started it is necessary to connect to a database 

using the Database Connection Wizard. However, the user may be presented with a login 

box automatically, or maybe logged in automatically. This is to allow the user to re-connect 

to the last database which was used without having to go through the Database 

Connection Wizard. 

3.1.1 Option 1 - Connect to a database (Database Connection Wizard) 

Use the following steps to connect to a database. 

1. To connect to an existing database, click the Database > Connect… main menu item 

to launch the Database Connection Wizard. 

2. On the Database Server page, enter the Server Name of the SQL Server. 

3. This will be the machine name or IP address of the SQL Server machine followed by 

the SQL Server instance name.  E.g. myMachine\mySQLServer. 

4. On the Specify Database page, choose the database from the Existing NEXUS IC 

Databases drop-down box. 

5. If necessary, enter the Username and Password on the credentials page of the 

wizard. 

6. Finish the wizard. 

 

3.1.2 Option 2 - Log into a previous database 

If you are given the option to log into the last used database enter the password to log in.  If 

you do not wish to log into the last used database click on Cancel or Database > Close 

and then use Option 1 above to connect to a database. 

 

Activity: 

Start IC-Inspection and connect to the training database. 

Your tutor will tell you the correct SQL server name and database to 

connect to and the login credentials to use. 
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3.2 Configure online desktop with common windows 

IC-Inspection has a configurable desktop display.  You can: 

 If you are using dual screen monitors, extend the IC-Inspection screen across both 

monitors before configuring desktop windows. 

 Decide which windows you want to display on the screen and how they are organized. 

 Adjust position, height and width of each of the windows to suit the current Inspection 

task. 

 Add/remove windows from the desktop using the View menu button on the main 

toolbar. 

 Pin and un-pin windows so that they auto-hide when not in use. 

 “Float” windows so that they appear as separate windows outside IC-Inspection’s main 

application window. 

 Set-up and save different desktops. 

 

Activity: 

Setup desktop titled “Shift Check”. 

See Appendix 1 – DESKTOP CONFIGURATIONS for an example of a 

“Shift Check” desktop. 

Tip: Remember to save your desktop when you are finished. 

 

Activity: 

Setup desktop titled “Structural Eventing”.  

See Appendix 1 – DESKTOP CONFIGURATIONS for an example of a 

“Structural Eventing” desktop. 

Tip: See what happens to the Event Launcher window if you select an 

asset type that has no available events. 

Tip: Remember to save your desktop when you are finished. 

 

Activity: 

Setup desktop titled “Pipeline Eventing”. 

See Appendix 1 – DESKTOP CONFIGURATIONS for an example of a 

“Pipeline Eventing” desktop. 

Tip: Remember to save your desktop when you are finished. 
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3.3 Pre-inspection checks 

Before you commence inspecting and logging inspection data, there are some checks that 

need to be performed to ensure that the system is configured correctly to log events to the 

correct asset and workpack, and to ensure that video and survey data interfaces are 

working. 

 

 

3.3.1 Check device connections (Video Recorder / Survey String / Text Overlay) 

IC-Inspection can be configured to interface with many different types of devices for 

inspection control and information transfer. These can include Survey/Positional inputs or 

outputs and Video Recorder systems. 

Where compatible, IC-Inspection will control all starting and stopping of recording on the 

video recorder device. This interconnection must be tested. This can be done by 

performing an audio/video test recording. Clicking Start in IC-Inspection should start 

recording on the recorder and clicking Stop should stop recording. 

Any Text Overlay configuration can be tested by making sure that any information being 

supplied by IC-Inspection is being correctly displayed on the text overlay on the video 

recorder screen. 

  

Check device 
connections and 
incoming survey 

data 

Check correct 
workpack 

Check correct 
asset 

Check tasks to be 
performed 
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Survey string data can be checked by examining the data displayed on the IC-Inspection 

Survey Values window. Any of the following can indicate a problem with survey data: 

 Fields which alternate between two different values which differ substantially. 

 Fields which alternate between a value and blank. 

 Fields which contain erroneous data (i.e. positional data that is wildly out, heading and 

depth which are wildly out). 

 Date and Time values that are erroneous (Out of sync by one hour, one day, one year 

etc.). 

 

Alternatively, if values are dark red in the IC-Inspection Survey Values window, this will 

indicate that there is a problem with the incoming survey data: 

 

Figure 3.1 – Survey Values window 

 
If any of these are present then please contact your NEXUS IC administrator or contact 

support@nexusic.com. 

  

mailto:support@nexusic.com
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3.3.2 Check workpack 

 

Figure 3.2 – Active Inspection window 

 
The Active Inspection window shows the current database which you are connected to, the 

current workpack, current survey set and optionally the currently selected event template 

group. 

The workpack should be the current inspection workpack.  It will contain all of the tasks for 

the current inspection and any events created will be against this workpack, so it needs to 

be correct! 

The survey set should be set to the correct one for the current ROV. This will identify the 

video recording for any events that you create. If you are never using more than one ROV 

simultaneously, a single survey set will be sufficient. 

You should check that all of the settings on this window are correct before starting 

inspection. 

Activity: 

Using the “Shift Check” desktop, check that you have the correct 

settings in the Active inspection window. Click on the Workpack, Survey 

Set and Event Template Group ‘…’ ellipsis buttons to view alternate 

options for selection. 
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3.3.3 Check correct asset 

Before starting, we need to make sure that we are on the correct asset. This can be done 

using the Assets Window as shown in Figure 3.3 - Assets window. 

 

 

Figure 3.3 - Assets window 

 
Each client’s database will be configured differently. The hierarchy will contain different 

asset types and the groupings may differ from client to client. 

The Assets window is a hierarchical list of all of the assets in the database. You can “drill 

down” into the hierarchy levels until you locate the asset you are going to inspect. The 

Assets window controls the source of information for many other windows in the system, so 

when you select an asset in the hierarchy all of the events in the Event Listing window will 

be against the selected asset, all of the tasks listed in the Tasks window will be for the 

selected asset, etc.  
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In addition, it is possible to navigate to assets in the hierarchy using drawings.  If the item 

exists on a high level drawing then clicking on it will present the option to navigate to it in 

the hierarchy.  See the drawings window below in which a field overview drawing is being 

used to navigate to the 24” Gas Export Pipeline. 

 

Figure 3.4 - Drawings window 

 

Activity: 

Experiment with selecting assets from the hierarchy.  Note how 

information changes in the tasks window when you select a different 

asset. 

 

  



 
Wood 
NEXUS IC Offshore Operator Training Course  
 

 Page 12 of 44 301-WG-MNL-002 Rev 05 
   

3.3.4 Check tasks to be performed 

Once you have selected the correct asset from the hierarchy in section 3.3.3 above you will 

need to check the tasks which need to be completed as part of the current workpack.  This 

can be done using the Tasks window, shown in Figure 3.5 below. 

 

Figure 3.5 - Tasks window 

The Tasks window provides the following functionality: 

 Task Information including instructions. 

 Launch task as an event. 

 Modify task information. 

 

Activity: 

Select a few different assets to see what tasks are available.  Try 

selecting the root (top level) node with the Child Assets button 

depressed – this will show all tasks that have been selected for the 

current workpack. 
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3.4 Online inspection 

Activity: At this point ensure you switch to the “Pipeline Eventing” desktop. 

 

3.4.1 Starting and stopping inspection 

To enable on-line data capture, you must first “Start” the inspection. Several things occur in 

the background when the inspection is “Started”: 

 Any video recording devices which are interfaced with IC-Inspection start recording. 

 Survey data will commence logging. 

 

It is recommended that when you “Start” inspection, you wait until all video recorders are 

reported as recording before commencing video commentary and data acquisition. When 

IC-Inspection is in inspection mode, the Start button will disable and the Stop button will 

enable (as shown in Figure 3.6). 

  

“Stand-by” mode  “Inspection” mode 

Figure 3.6 – IC-Inspection workspace background in both modes 

Activity: 
Alternate between “Inspection” mode and “Stand-by” mode. Note the 

informational message at the bottom right of the main window. 

3.4.2 Creating Events from Tasks 

Certain clients will pre-populate their database by defining what tasks are to be carried out 

on what components.  As a general rule, pre-populated tasks are generally defined for 

subsea structures and equipment. 

Tasks can be launched either from the Tasks window or from the Drawings window.  

When a task is launched, the associated event form will be created in the Active Events 

"Start" Inspection 
(Inspection mode) 

"Stop" Inspection 
(Stand-by mode) 
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window.  You will be required to fill-in the fields in the form, then save the event.  

IC-Inspection will automatically mark the task as being completed. 

Activity: 

Using the “Pipeline Eventing” desktop, choose any of the subsea 

pipeline assets and create events from the Tasks window and the 

Drawings window. See section 3.8 Advanced Features – Drawings for 

more information on creating events from drawings. 

 

3.4.3 Creating Ad Hoc Events 

At any time, whilst IC-Inspection is in inspection mode, you can log events against the 

currently selected asset. This is what we refer to as “ad-hoc eventing”. 

Note: You are not restricted to only eventing from the pre-defined tasks! 

Ad-hoc events are created from the Event Launcher. The events available appear in the 

Event Launcher and the list is dependent on the “type” of asset that is currently selected.  

For example, a Span event is not visible when you have a VDM asset selected. See 

example of the events toolbar in  

Figure 3.7 below. 

 

Figure 3.7 – Event launcher 

Events appear in the launcher grouped by category and ordered alphabetically. 
  



 
Wood 
NEXUS IC Offshore Operator Training Course  
 

 Page 15 of 44 301-WG-MNL-002 Rev 05 
   

3.4.4 One-click eventing 

One-click eventing is commonly used during pipeline inspections. The Event Templates 

window allows you to pre-configure events (with fully or partially populated information) and 

assign hot keys to those events. Event Templates can then be launched either by pressing 

the hot key you have chosen, or by clicking the template’s button in the Event Launcher. 

 

Figure 3.8 - Event Templates window 

 
The configuration window is used to create/modify event templates. Generic data includes: 

 Template Name Can be anything you like. Try to place key information near the start  

   of the name, so it’s easily visible in the Event Launcher button. 

 Shortcut Key Can be a variety of different key strokes, enter by performing the 

   keystroke on the keyboard. You can hold down Shift, Ctrl or Alt while 

   choosing a key if you like. 

 Shortcut Action Events can be launched and left open for editing, launched and  

   immediately saved (One-click Record) or launched and left open  

with a recorded image attached. 

 Event Type The event type to launch. 

 Event Details Once you have selected the Event Type the Event Details pane will 

   become available. Here you can configure any default data. 
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Figure 3.9 - Event Template configuration window 

 

Note that to make events from your template group available for launching, you must select 

your event template group in the Active Inspection window. 

 

Activity: 
Set up some event templates of your own now. 

Use the various ‘Actions’ available when setting up your event templates. 
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3.4.5 Active Events window - overview  

 

Figure 3.10 – Active Events window 

 
The Active Events window displays any active events – events you’ve launched but not yet 

saved. If you have multiple events open at once, you will see a tab for each open event. 

Select an event’s tab to see its data. 

When an event is created (either ad-hoc or from a task) the event will appear in the Active 

Events window. At the point the event is created, IC-Inspection will store any available 

survey data as start information for the event. Once the event is finished (e.g. End of Span) 

the event should be saved using the Save button. This will update the event end 

information using any live survey data.  The Survey tabbed page can be used to view any 

recorded survey data for the selected event.  Events can also be cancelled using the 

Cancel button ( ). 

More than one event can be active in the Active Events window at any given time, and 

events can be created/saved in any order. 
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Figure 3.11 - Event Details 

The Details tabbed page displays the fields 

that need to be completed by the online 

inspection engineer. The information 

recorded will differ by event type. 

 

 

Figure 3.12 - Survey data 

The Survey tabbed page displays survey 

positional data. This survey data is normally 

populated automatically by the incoming 

survey strings. When an event is triggered, 

the start information is populated and when 

the event is saved the end information is 

populated. 

 

 

Figure 3.13 – Multimedia 

The multimedia tab is used to show any 

multimedia (normally photos) against the 

current event. Multimedia types can include 

images or video files. If your digital video 

recorders support it, IC-Inspection can 

initiate an image grab from each video 

recorder and store those images directly in 

the database. See section 3.4.6 below for 

more details. 
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3.4.6 Event Image Capture 

Some video recorder applications allow an image capture to be triggered and transferred 

back to IC-Inspection (for example IC-Recorder, EdgeDVR and NETmc DVRi do). 

An image capture can be triggered by clicking on the Capture Image button on the Active 

Events window.  See Figure 3.14 below. 

 

Figure 3.14 - Image Capture 

 

Activity: 

Experiment with creating events and adding Event Details and 

Multimedia. Try a variety of Asset Types and Event Types. 

Create events from Tasks, Ad-Hoc eventing and Event Templates. 
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3.4.7 Automatic Findings from Anomaly Triggers and manually raising a Finding 

In NEXUS IC, an event which records a situation that is out of specification or out of range 

is raised to a finding. Findings can then be reviewed and if necessary linked to an anomaly.  

In the case that an event is recorded and raised to a finding over different inspection years, 

these findings are all linked to the same anomaly. Figure 3.15 below shows how events are 

raised as findings and then, if necessary, linked to anomalies. 

 

Figure 3.15 - Event, Finding and Anomaly structure 

Anomaly triggers are used to set the point at which NEXUS IC will decide that an event 

should be raised as a finding. These anomaly triggers are configured using NEXUS IC and 

are configured specifically to client anomaly criteria. Examples include span maximum 

length and height, low and high CP, metallic debris. 

If a field has an anomaly trigger defined, and the value for that field is out with the trigger 

boundaries, the field will be marked with a yellow exclamation mark ( ).  

 

Figure 3.16 - Anomaly message 

 

Anomaly A1 

Finding Raised 
(Linked to A1) 

Inspection Event 
from 2010 

Finding Raised 
(Linked to A1) 

Inspection Event 
from 2011 

Anomaly A2 

Fining Raised 
(Not Linked to an 

Anomaly) 

Inspection Event 
from 2002 

Finding Raised 
(Linked to A2) 

Inspection Event 
from 2005 

Finding Raised 
(Linked to A2) 

Inspection Event 
from 2007 
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When you save the event, a finding will automatically be generated. If you want to add a 

finding to an event which does not have any yellow exclamation marks showing, toggle the 

Raise a Finding button. 

In the Event Listing window, events with findings will have a yellow rectangle in the “F” 

column, indicating the presence of the finding. The event will also have an extra tab titled 

“Findings”. This tab is a list of all the findings for that event. You can select a finding and 

click Edit (or just double-click the finding) to edit it. You can also Add or Delete findings. 

 

Figure 3.17 - Findings tab on the Event Listing window 

If you relaunch the event, the Active Events window entry for the event will have an extra 

tab called Finding, which displays only the first finding for the event. (It’s unusual for a 

single event to have more than one finding.) Again you can toggle this with the Raise a 

Finding button. 

 

Activity: 
Experiment with creating events that have out of specification data.  See 

where Findings are created automatically. 

 

Activity: 
Experiment with creating Findings on events manually using the ‘Raise a 

Finding’ button. 

 

Activity: Experiment with manually adding and deleting Findings. 
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3.5 Advanced Features – Assets 

Table 3.1 - Functionality in the Assets window 

ITEM DESCRIPTION 

< Previous Asset 

> Next Asset 
These buttons let you navigate to previously selected assets. 

Assets > Show 

Asset Type 

This menu button will enable/disable the Asset Type column in the asset 

hierarchy. 

Asset Views 
If your database has multiple different asset views, this menu button will 

let you choose which one to display. 

Traffic Lighting 
This menu button will let you select a traffic light. The Incomplete Tasks 

traffic light is often useful during inspection. 

 

3.6 Advanced Features – Asset Information 

The Asset Information window displays any Asset Information Group (AIG) forms that are 

associated with the currently selected asset. These AIG Forms hold any asset specific 

information about the current asset. 

 

Figure 3.18- Asset Information window 
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3.7 Advanced Features – Tasks 

Table 3.2 - Functionality in the Tasks window 

ITEM DESCRIPTION 

Launch 

During inspection, clicking this will launch the selected task as a new 
event. It is also possible to do the same thing by double clicking on the 
task in the table. This option will be disabled if there are no tasks in the 
window or you are not in Inspection Mode. 

Launch 
Template 

If there are event templates of the appropriate type to complete this task, 
you can choose one to launch from this drop-down. For example, if the 
task is “Anode”, and you have an Event Template called “Anode 25%”, 
you could pick that template from the drop-down. This may be faster than 
launching the task and filling in the form yourself. 

Edit Edit the task. 

Navigate to 
Asset 

If you have Child Assets or Parent Assets selected, you can click on a 
particular task and click Navigate to Asset to move the selection in the 
Assets window to the specific asset that this task is on. 

Filter Filter lets you show or hide completed tasks. 

Child Assets 

If depressed, the Tasks window will show tasks on the asset selected in 
the Assets window and on all that asset’s descendants. Clicking on the 
very top asset and depressing Child Assets will show all tasks in the 
selected workpack. 

Parent Assets 
If depressed, the Tasks window will show tasks on the selected asset plus 
any tasks on its ancestors. 

Instructions 
If depressed, you will see a pane at the right of the Tasks window 
showing any instructions that have been set up for this task. 
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3.8 Advanced Features – Drawings 

 

Figure 3.19 - Drawings window 

 

The Drawings Window will display any drawings or photos that are available for the 

selected asset. Where more than one drawing or photo exists for the selected asset a 

thumbnail bar will appear with a preview icon of each of the available drawings or photos. 

These can be selected to view. 

The Drawings window includes regions which overlay the drawing/photo allowing specific 

areas to be highlighted. The regions are always linked to an asset and provide the following 

functionality: 

1. Colouring to illustrate the following: 
  Red Asset has tasks in this workpack and none have been completed. 

  Orange Asset has tasks in this workpack and some, but not all, have been 
completed. 

  Green Asset has tasks in this workpack and all have been completed. 

  Grey Asset has no tasks in this workpack. 

2. Clicking on the region will show an options list that allows the user to: 
  Navigate to the asset. 
  Launch an associated task for the asset. 
  Navigate to any of the asset’s children that have tasks in this workpack. 
  Launch any task associated with the asset’s children. 
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Figure 3.20 - Drawing showing region colouring and navigation menu 

 

Table 3.3 - Functionality in the Drawings window 

ITEM DESCRIPTION 

Include Parent 
When depressed, you can pick from drawings on this asset and on its 

parent assets. 

 

The View Menu gives a selection of viewing and zooming options. The 

“Caption” option lets you display a caption on each layer showing text 

from an Asset Information field, or from an event field for events logged 

on the assets represented by each layer. 

 

The Colour Menu lets you choose how layers on the drawing are 

coloured. “Tasks” is often the most useful selection when inspecting. 

 
The drawings window supports the following navigational controls: 
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Table 3.4 – Drawings mouse and keyboard shortcuts 

Action Applies to Keyboard & Mouse Combination 

Move Drawing Left mouse button click & drag. 

Navigate 
Button 

Left mouse button click. 
Region 

Zoom In 
Drawing 

Mouse wheel up. 

Zoom Out Mouse wheel down. 

 

3.9 Advanced Features – Events 

Table 3.5 - Functionality in the Active Events window 

Item DESCRIPTION 

Save Saves to the database and closes the active event. 

Save and 
New 

Saves to the database and closes the active event, then creates a new 
event of the same type. 

Cancel 

Cancels the active event. If the event has not previously been saved, then 
no changes are made to the database. If the event has been previously 
saved, then any edits to the event are cancelled and the event will be 
saved back to the database. 

Raise a 
Finding 

Raises a Finding on the active event. 

Capture 
Image 

Where hardware configuration allows, a photo is attached to the active 
event.  

Bookmark Add a bookmark to the active event. 

Update Start 
When clicked, this will update the start date/time and survey position data 
for the active event. 

Pause End 
When clicked, this will cease updating the end survey position data for the 
active event. 

 
 

3.10 Advanced Features – Event Listing 

Table 3.6 - Functionality in the Event Listing window 

ICON DESCRIPTION 

Relaunch 
This button will launch the selected event for editing. This will move the 
event back into the active events list. 

Delete Deletes this event. 

Events 
This menu lets you navigate to the event’s asset in the Assets window, 
update the event’s start or end survey time from live survey time, or toggle a 
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bookmark that will be visible to the off-line reviewer. 

Filter 
This lets you filter for a subset of events on this asset. If you filter by time 
you’ll only be shown events logged in the last 1 hour, 2 hours, etc. 

Child 
Assets 

This button will include events in the list which have been logged against 
any child assets. 

Details 
The Details button will toggle the display of the event details portion of the 
window (Event, Survey, Comments, Multimedia, Findings tabs). This view is 
read-only. 

 

3.10.1 Historical Event Listing workpack filter 

The Historical Event Listing window has an extra item in its Filter menu which allows the 

events in the listing to be filtered by Workpack. 

It should be noted that the Historical Event Listing window can be configured to show 

events from a different Workpack to that configured in the Active Inspection window (See 

section 3.3.2 above). This means that events from different workpacks can be compared 

side-by-side during inspection. 

3.11 Advanced Features – Pipeline Views 

Activity: 
Navigate to 2009 ROV workpack, select the 24” GEP Pipeline and finally 0 

KP point. This should allow you to find events within this range. 

 

 

Figure 3.21 - Pipeline View 

 

IC-Inspection includes a Pipeline View window which overlays events on top of a graphical 

pipeline representation.  The view can be configured using a variety of filters to show 

events on the current pipeline. The pipeline view uses KP positional data from survey to 

determine the ROV’s current position on the pipeline. Seabed cross-profile is not typically 

available in real time. 
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Table 3.7 – Functionality in the Pipeline View window 

ITEM DESCRIPTION 

Zoom In Zoom in. you can also click in the view and use the mouse wheel. 

Zoom Out Zoom out. you can also click in the view and use the mouse wheel. 

Reset 
Zoom 

This button can be used to reset the zoom level of the pipeline view. 

Perspective 
Toggle between looking at the pipeline sideways-on and looking at it in 
perspective. 

Exaggerate 
Scale 

Increases the apparent height of seabed bumps to make them more visible. 

Stacked Pops events out and shows them above the pipeline. 

Track KP 
Toggles between showing the current KP from live survey vs showing the 
KP from the event selected in the Event Listing window. 

 

3.12 Pipeline inspection simulation 

Activity: 

Your instructor will now commence a video of a pipeline inspection 

using an ROV.  You should treat this as footage of an inspection you are 

carrying out and event accordingly. 

Navigate to the 24” GEP pipeline asset, remembering to create events 

from the pre-defined tasks, ad-hoc events and events from event 

templates. 

 

3.13 Structural inspection simulation 

Activity: 

Your instructor will now commence a video of a structural inspection 

using an ROV.  You should treat this as footage of an inspection you are 

carrying out and event accordingly. 

Navigate to asset R3901, remembering to create events from the pre-

defined tasks, ad-hoc events and events from event templates. 
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4.0 OFFLINE REVIEW USING NEXUS INTEGRITY CENTRE 

Offline Review is carried out using NEXUS IC. 

4.1 Start NEXUS IC and connect to database 

NEXUS IC is started by navigating to Start > All Programs > NEXUS and clicking on 

NEXUS Integrity Centre. Once the software has started it is necessary to connect to a 

database using the Database Connection Wizard, however, the user may be presented 

with a login box automatically. This is to allow the user to re-connect to the last database 

which was used without having to go through the Database Connection Wizard. 

4.1.1 Option 1 - Connect to a database (Database Connection Wizard) 

Use the following steps to connect to a database. 

1. To connect to an existing database, click the Database > Connect… main menu item to 

launch the Database Connection Wizard. 

2. On the Database Server page, enter the Server Name of the SQL Server. This will be the 

machine name or IP address of the SQL Server machine followed by the SQL Server 

instance name.  E.g. myMachine\mySQLServer. 

3. On the Specify Database page, choose the database from the Existing NEXUS IC 

Databases drop-down box. 

4. If necessary, enter the Username and Password on the Credentials page of the wizard. 

5. Finish the wizard. 

 

4.1.2 Option 2 - Log into a previous database 

If you are given the option to log into the last used database enter the password to log in. If 

you do not wish to log into the last used database click on Cancel and then use Option 1 

above to connect to a database. 

 

Activity: 

Start NEXUS IC and connect to the training database. 

Your tutor will tell you the correct SQL Server Name and Database to 

connect to. 
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4.2 Overview of Review in NEXUS IC 

 

Figure 4.1 - NEXUS IC navigation pane and application categories 

In NEXUS IC, Offline Review is performed from the Inspection area. To navigate to 

Inspection, select Inspection from the navigation pane (See Figure 4.1 above). 

 

Figure 4.2 – NEXUS IC Inspection screen 

 

Navigation pane and 
Application Categories 

Asset 
Hierarchy 
and Filters 

Event Listing 

Event 
Details 

Findings Summary 

Multimedia, 
Tasks and 
Findings 
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The Inspection screen is broken up into several sub-windows. These windows can be 

rearranged, “torn off” to float outside the main application window, and toggled on/off via 

the View menu button. 

4.2.1 Asset Hierarchy and Filters 

The Assets window contains the asset hierarchy. This hierarchy can be used in the same 

way as the IC-Inspection hierarchy described in section 3.3.3 above. 

The Filters menu button is used to filter the events listed in the Event Listing by Workpack 

or Event Type. 

 

 

Figure 4.3 – Workpack Filters 

 

Figure 4.4 – Event Filters 

The Workpack filter is set by 

putting check-marks next to the 

correct workpack(s). While 

performing review the correct 

workpack should always be 

selected. If additional workpacks are 

selected, or none are selected (All) 

then you will see events from 

previous years interlaced with the 

current events. This can lead to 

confusion. 

The Event Type can be set by 

selecting it from the list.  More than 

one can be selected at a time. Right 

clicking will provide options to 

Select All, Unselect All and Invert 

Selection. 

The Include Child Assets button 

can be selected to include any 

events that exist on child assets. 
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Filters can also be set on grid columns. For example, you can filter the Start Clock column to cover 

a particular range of dates and times. 

Selected filters will show at the bottom of the Event Listing grid. To clear a filter, click the ‘X” at its left 
side. 

4.2.2 Event Summary 

The Event Listing is a grid listing of events that have been logged against the selected 

asset and which match the configured filtering criteria. Event data is shown in the grid 

columns. 

4.2.3 Event Details 

The Event Details area shows information specific to the event selected in the Event 

Listing grid. As with the Active Events window in IC-Inspection, the Survey and 

Comments Tabbed pages are available here. 

4.2.4 Findings Summary 

The Finding Listing is a grid listing of Findings that have been recorded against the 

selected asset and which match the configured event filtering criteria. 

4.2.5 Multimedia, Task, Findings 

The Multimedia window shows any multimedia that have been recorded against the 

selected event. Images can be added or removed. 

If the selected event was launched from a task, the Task window shows that task. 

The Findings area provides details of any findings on the selected event only. 

Activity: 

Use the asset hierarchy and filters tabs to find the events you created 

during your mock pipeline and structural inspections. 

Use the Events and Findings Summaries to browse the event and finding 

data. 

Use the Events Details to view the event data. 
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4.3 Inspection overview 

The primary objectives of reviewing inspection data are to ensure that:  

 Any inspection events have findings have sufficient supporting evidence attached 

(e.g. photos/video still and event information). 

 Inspection events which have been specifically bookmarked by the online inspection 

engineer/s are reviewed. 

 Review of all inspection events recorded. 

 Multimedia attached to inspection events are of good quality. 

 The date/timestamp of the inspection events recorded match the actual start 

date/timestamp and end date/timestamp indicated on the Digital Video. 

 

Additionally, once the date/time stamps of the events have been reviewed and confirmed, 

then Track Repositioning can be performed and Anomaly Triggers re-run against updated 

survey fields. 

 

 

Figure 4.5 - Data review process 

  

Step 1 

•Review and Report 
Findings 

Step 2 

•Review Bookmarked 
Events 

Step 3 

•Review all other 
data 

Step 4 

•Track Reposition 

Step 5 

•Re-run Anomaly 
Triggers 



 
Wood 
NEXUS IC Offshore Operator Training Course  
 

 Page 34 of 44 301-WG-MNL-002 Rev 05 
   

4.4 Review events with findings 

All findings recorded by the online inspection engineers in IC-Inspection are identified in the 

Event Summary pane by a yellow rectangle in the column titled F. You can click on the 

Column heading F to sort the grid so that all findings are at the top, or filter that column so 

that only events with findings are displayed. Events marked with a red rectangle have one 

or more findings that have an open Anomaly connected to them. Events marked with a 

grey rectangle have one or more findings connected to a closed-out Anomaly. 

 Check the video and ensure that the timestamps for the start event and end event are 

correct (keyboard shortcuts: 7/Home & 9/PgUp on the numeric keypad for Start and End 

respectively). 

(Please note: For information regarding updating Event Start and End times please see 

section 5.2 on page 40) 

 Check that the event form is complete and that all data and comments are accurate and 

concise. 

 Check that any multimedia attached to the event are of good quality; delete any bad 

quality or extraneous multimedia, or add more/clearer ones to the event if necessary 

 Ensure that the Finding Description is accurate and concise. 

 Ensure that the correct Findings code has been assigned. 

 Mark the event as reviewed and continue to the next finding (keyboard shortcut: 0/Ins on 

the numeric keypad). 

 

 

Figure 4.6 - Events with findings 
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Activity: 
Use the procedure above to review any events that you created during 

your mock pipeline inspection that contain findings. 

 

4.5 Review bookmarked events 

Online inspection engineers may bookmark any event for specific review by the offline data 

review team. When online inspection engineers have utilised the Bookmarking functionality 

in IC-Inspection the offline data reviewer will be required to pay special attention to these 

events. 

All bookmarked events recorded by the on-line inspection engineers in IC-Inspection are 

identified in the Event Summary pane by a star icon in the column titled B (See Figure 4.7 

below). To sort the grid so that all bookmarked events are at the top, click on the Column 

heading B. You can set or clear a bookmark by right-clicking on the event and choosing the 

appropriate menu option. 

 Check the video and ensure that the timestamps for the start event and end event are 

correct (keyboard shortcuts: 7/Home & 9/PgUp on the numeric keypad for Start and End 

respectively).  

(Please note: For information regarding Updating event start and end times please see 

section 5.2 on page 40). 

 Check that the event form is complete and that all data and comments are accurate and 

concise. 

 Check that any multimedia attached to the event are of good quality; delete any bad 

quality or extraneous multimedia, or add more/clearer ones to the event if necessary. 

 If required this bookmarked event can be raised to a finding. 

 Mark the event as reviewed and continue to the next bookmarked event. 

 

 

Figure 4.7 - Bookmarked events 
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Activity: 

Use the procedure above to review any events that you created during 

your mock pipeline inspection that contain bookmarks. 

Tip: Remember to toggle bookmarks off once reviewed! 

4.6 Reviewing events by date/time 

Once Findings and Bookmarked events have been reviewed the process of data review 

can continue on all other recorded events. It is standard practice to review the events from 

oldest to newest. 

To sort the Events by Date/Time, click on the Start Clock column heading. 

 Check the video and ensure that the timestamps for the start event and end event are 

correct (keyboard shortcuts: 7/Home & 9/PgUp on the numeric keypad for Start and End 

respectively).  

(Please note: For information regarding Updating event start and end times please see 

section 5.2 on page 40). 

 Check that the event form is complete and that all data and comments are accurate and 

concise. 

 Check that any photos attached to the event are of good quality, delete any bad quality or 

extraneous photos or add more photos to the event if necessary.  

 Mark the event as reviewed and continue to the next event (keyboard shortcut: 0/Ins on 

the numeric keypad). 

 

Reviewed events are highlighted in the Event Summary window in blue (see Figure 4.8 

below). 

 

Figure 4.8 – Event Summary 

Activity: 

Use the procedure above to review the remaining events in Date / Time 

order. 

Tip: Open the Pipeline View tab and play the inspection video from the 

Events that have been reviewed 

Events that are yet to be reviewed 
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beginning (starting from the first GVI event) all the way through to the 

end. Review the events and add any missed events if necessary. 

4.7 Post-processing survey data 

4.7.1 Track Repositioning 

After the data has been reviewed and the Date / Time stamps of each of the events has 

been cross-checked and updated against the DV, the post processed survey data 

(normally supplied by the contracted survey company) will need to be used to update the 

NEXUS IC database by importing that processed survey data as a new Survey Set. 

4.7.2 Processed Data (Smoothed) Files 

Track Reposition requires a 'CSV' or MS Excel file of the processed survey data, most 

likely in the format originally provided in the survey string.  For example: 

#Fields:DateTime, KP, Easting, Northing, Depth, CPReading, FieldGradient 

15/03/2005 10:19:37, 0.8372, 143436.27, 6441508.37, 266.28, 0, 0 

15/03/2005 10:19:38, 0.8374, 143438.28, 6441506.36, 266.3, 0, 0 

15/03/2005 10:19:39, 0.8376, 143440.29, 6441504.35, 266.32, 0, 0 

 

A header line or lines is required to identify the elements of each subsequent line of data.  

There are no restrictions on the number, naming conventions or order of data fields within 

each line and in addition the date/time format is somewhat flexible. 

The Survey contractor needs to be made aware that post processed data is required 

and that it should not be discarded. It may be helpful to provide the survey contractor 

with a listing of times during which events were recorded so that they can provide the 

correct data. 

The ‘smoothed’ data provided by the surveyors MUST contain data points with 

intervals of no more than 5 seconds. 

4.7.3 Interpolation and Threshold 

Track reposition works by matching the event date and time to a line entry in the processed 

data file. It then takes the survey data entries on that line and saves them into the event 

survey data. When an exact date and time match cannot be found NEXUS IC can 

interpolate values for the survey data based on the preceding and following line entries.  If 

no matching date time values exist within the threshold NEXUS IC will not return any 

survey values.  
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4.7.4 Procedure 

We recommend that Track Repositioning be performed one pipeline (or asset) at a time. 

 Select one of the events which is to be repositioned. 

 Go to the Event Details window.  

 Click the Survey tab. 

 Click the “…” ellipsis button next to “Survey Set”. 

 In the resulting “Select Survey Set”, click “+” to add a new survey set if necessary. 

 Click the Import button to launch the Import Survey Sets Wizard. 

 On the Source File page of the wizard use the ellipses button […] to browse to the CSV/ 

Excel file, click Next. (The Survey Set import code is not yet written.) 

 (Please note: This will not make any changes to the database at this point). 

 Once you have imported your new Survey Set, select all the events to be repositioned 

(click the first one, then shift-click the last one), click the “…” ellipsis button next to 

“Survey Set”, and select the desired survey set. 

 If you later wish to revert, simply select the events again and select the Raw Survey Set 

for them again (or whatever other survey set is desired). 

 

Activity: Perform a track reposition on your pipeline inspection events. 
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4.7.5 Re-run Anomaly Triggers 

Once Track Repositioning has been performed, then the Anomaly Triggers utility can be re-

run over the inspection data. This means that you can now correct the survey data that 

might trigger anomalies where previously they didn’t. This can create new findings and 

remove previous findings. 

For example: Anomaly Triggers have been defined for a particular pipeline where spans 

over 15m are deemed to be anomalous. The raw survey data of a Span event had defined 

a start KP of 1.458 and end KP of 1.472 (with a calculated span length of 14m). However 

after post-processing the data the start KP is 1.457 and the end KP is 1.473 resulting in the 

new span length being 16m. Running the Anomaly Triggers utility will pick up the new span 

length and flag the event as a finding because it is now outside the anomaly limit. 

To run the Anomaly Triggers click on the Tools | Anomaly Triggers toolbar button in the 

Event Summary window. 

 

Figure 4.9 - Anomaly Triggers 

 

Activity: 

Re-run the Anomaly Triggers on your pipeline inspection events. 

Tip: Try adding a debris event (if you don’t already have an example) and 

select ‘Metallic in Contact’ then re-run the anomaly trigger. 

 



 
Wood 
NEXUS IC Offshore Operator Training Course  
 

 Page 40 of 44 301-WG-MNL-002 Rev 05 
   

5.0 HOW TO: 

5.1 Database backups 

When the database server is the Review PC we recommend performing a database 

backup every six hours. 

When the database server is the IC-Inspection PC then we recommend performing a 

database backup at the end of every shift AND at least once during the shift if there is 

sufficient downtime. 

If the server is an independent SQL server we recommend performing a database backup 

at the end of every shift AND at least once during the shift if there is sufficient downtime. 

5.2 Update event start/end from the digital video 

Timestamps for the start and end of an event are viewable from the Survey tabbed page of 

the Event Details pane. 

When reviewing data from digital video, the start and end time of the event can be 

automatically updated from the date and time of the digital video currently playing. 

To update the start time of the currently selected event to the date/time of the Digital Video, 

ensure that the Time button on the Connect DVR toolbar is DOWN (see Figure 5.1 below). 

 

Figure 5.1 - DVR timings 

 

When the Time button is up the local time is displayed. This is useful in scenarios where no 

digital video is present. 

The start time of the currently selected event can be updated by clicking on the Events | 

Update Start toolbar button on the Event Summary toolbar (See Figure 5.2 below). The 

keyboard shortcut is the number 7/Home on the numeric keypad (ensure that Num Lock is 

off). 

The end time of the currently selected event can be updated by clicking on the Events | 

Update End toolbar button on the Event Summary toolbar. The keyboard shortcut is the 

number 9/PgUp on the numeric keypad (ensure that Num Lock is off). 
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Figure 5.2 - Events Summary updating start/end 

 

After the event is reviewed, click on the number 0/Ins on the numeric keypad (ensure that 

Num Lock is off) – this will mark the currently selected event as reviewed and move to the 

next record.  

You can also select the reviewed event and then click on the drop-down list Events, scroll 

down to Event Reviewed and select Mark Event as Reviewed which will also highlight the 

event as reviewed (See Figure 5.3 below). 

 

 

Figure 5.3 - Events Summary reviewed 
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5.3 View all event fields in a grid 

By default the Event Listing grid displays all fields which are common to all event types 

(e.g. Event Name, Number, Start Date/Time, Asset, Comments etc.). 

 

Figure 5.4 - Events Summary showing common fields 

 

To display event specific data in the Event Summary grid, you must have only one Event 

Type in the grid. To do this, click on Filter | By Event Type…  toolbar button and check 

only one of the event definitions in the grid. 

Alternatively click on the Filters tabbed page in the Assets pane and check only one of the 

event definitions then click on Apply. 

 

Figure 5.5 - Setting an event filter 

 

Please note that using the in-grid filtering is not sufficient to display the event properties in 

the Event Summary grid. 
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Figure 5.6 - Events Summary showing filtered events 

5.4 Running reports 

During an inspection campaign, some clients may request that a report is generated from 

NEXUS IC. An example of this is if a client wished to see a report on the findings for each 

day. Each client’s database will be set up differently and therefore have different reports 

available in the Reports application category. 

To run a Report in NEXUS IC, carry out the following steps: 

1. Navigate to the Reports appplication category. 

2. Navigate to the report you wish to run.  

3. Right click on the report and select Export (Microsoft Word). 

4. Follow the export wizard to generate the report. 
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5.5 Keyboard shortcuts 

The default keyboard shortcuts in the Inspections | Review screen use the numeric 

keypad on a standard keyboard with the defaults shown in the image below. These 

shortcuts have been refined after numerous offshore inspection campaigns however they 

can be altered if required. 

To change the default keyboard shortcuts go to Tools | Options | Review | Keyboard 

Shortcuts (available from the Main Menu). 

 

 

Figure 5.7 - Keyboard shortcut keys 

 

See Appendix 2 for a keyboard shortcut layout that can be printed and used as reference 

during inspection review. 
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“SHIFT CHECK” DESKTOP 

Primary Monitor 

 

 

Active Inspection 

Drawings 

Assets 

Tasks 
Device Manager 

Survey Values 
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“STRUCTURAL EVENTING” DESKTOP 

Primary Monitor 

 

Secondary Monitor 

Drawings 

Active Inspection 
 

Event Templates 

Events 
Event Listing 

Tasks Assets 

Structural Eventing 
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“PIPELINE EVENTING” DESKTOP 

Primary Monitor

 

Secondary Monitor 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Active Inspection 
 

Pipeline View 

Compass Rose 

Event Templates 

Drawings 

Assets 

Events Event Listing 

Tasks 

Pipeline Eventing 
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7 / Home 
 

Update 

Event Start 

4 
 

Step Video 
Back n 
Secs 

1 / End 
 

Rewind 

Video 

/ * 
 

Move 
Video 

To Start 

- 
 

Move 
Video To 

End 

8 
 

5 
 

Toggle 

Play/Pause 

9 / PgUp 
 

Update 

Event End 

6 
 

Step Video 
Fwd n 
Secs 

 

2 3 / PgDn 
 

Fast Fwd 

Video 

. 
Del 

 

0 / Ins 
 
 

Mark Event as Reviewed 

 
 
 

Enter 
 
 
 
 

Toggle 
Summary / 

Event 

Detail 

 
 
 

+ 

 
 

NEXUS default keyboard shortcut layout 

Num 
Lock 

 

Must Be 

Off 


